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Module 3: Artemis

Module Artemis

Introduction
Artemis is a DNA viewer and annotation tool, free to download and use, written by Kim
Rutherford from the Sanger Institute (Rutherford et al., 2000). The program allows the
user to view a range of files, from simple sequence files (e.g. fasta format) to
EMBL/Genbank entries, as well as the results of sequence analyses, in a highly interactive
and intuitive graphical format. Artemis is routinely used by the Pathogen Genomics group
for annotation and analysis of both prokaryotic and eukaryotic genomes, and can also be
used to visualize mapped data from next generation sequencing. Several types/sets of
information can be viewed simultaneously within different contexts. For example, Artemis
gives you the two views of the same genome region, so you can zoom in to inspect
detailed DNA sequence motifs, and also zoom out to view local gene architecture (e.g.
operons), or even an entire chromosome or genome, all within one screen. It is also
possible to perform analyses within Artemis and save the output for future reference.

Artemis is not the best viewer for large genomes, so that later in the course you will be
introduced to IGV….

Aims
The aim of this Module is for you to become familiar with the basic functions of Artemis
using a series of worked examples. These examples are designed to take you through the
most immediately useful functions. However, there will be time, and encouragement, for
you to explore other menus; features of Artemis that are not described in the exercises in
this manual, but which may be of particular interest to some users. Like all the Modules in
this workshop, please remember:

IF YOU DON’T UNDERSTAND, PLEASE ASK!
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1. Starting up the Artemis software

In the terminal type
art &

A small start-up window will appear (see below). The directory is 
/export/projects/bioinfo3/to16r/BioinfoWorkshop/Data/Module_Viewer/ and contains all 
files you will need for this module. (You might have copied the data already somewhere else).

Now follow the sequence of numbers to load up the Salmonella Typhi chromosome sequence.
Ask a demonstrator for help if you have any problems.

3

4

For simplicity it is a good idea 
to open a new start up window 
for each Artemis session and 
close down any sessions once 
you have finished an exercise.

In the ‘Options’ menu 
you can switch 
between prokaryotic 
and eukaryotic mode.

Artemis Exercise 1

You can also start 
Artemis from the 
terminal window 
by typing ‘art’

1. Click ‘File’
2. Then ‘Open’

Single click 
to select file 
S_typhi.dna

Single click to open file in Artemis then wait

Change to ‘All Files’ if 
you want to display all 
the files in the directory.

Use this feature to choose 
the type of file to be 
displayed in this panel.
DNA sequence files will 
have the suffix ‘.dna’. 
Annotation files end with 
‘.tab’. You can also open 
‘.embl’ files.
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2. Loading an annotation file (entry) into Artemis
Hopefully you will now have an Artemis window like this! If not, ask a demonstrator for 
assistance.

Click ‘File’ then 
‘Read an Entry’

1

Entry = file

Now follow the numbers to load the annotation file for the Salmonella Typhi chromosome.

What’s an “Entry”? 
It’s a file of DNA 
and/or features 
which can be 
overlaid onto the 
sequence 
information 
displayed in the 
main Artemis view 
panel.

2

3 Single click to open file in Artemis then wait
(click ‘no’ if an error window pops up)

Single click 
to select file 
S_typhi.tab
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3. The basics of Artemis
Now you have an Artemis window open let’s look at what is in there.

1
2

3

4

5

6

7

8

1. Drop-down menus: There’s lots in there so don’t worry about all the details right
now.

2. Entry (top line): shows which entries are currently loaded with the default entry
highlighted in yellow (this is the entry into which newly created features are created).
Selected feature: the details of a selected feature are shown here; in this case gene
STY0004 (yellow box surrounded by thick black line).

3. This is the main sequence view panel. The central 2 grey lines represent the forward
(top) and reverse (bottom) DNA strands. Above and below those are the 3 forward and
3 reverse reading frames. Stop codons are marked on the reading frames as black
vertical bars. Genes and other annotated features (eg. Pfam and Prosite matches) are
displayed as coloured boxes. We often refer to predicted genes as coding sequences or
CDSs.

4. This panel has a similar layout to the main panel but is zoomed in to show nucleotides
and amino acids. Double click on a CDS in the main view to see the zoomed view of
the start of that CDS. Note that both this and the main panel can be scrolled left and
right (7, below) zoomed in and out (6, below).

5. Feature panel: This panel contains details of the various features, listed in the order
that they occur on the DNA. Any selected features are highlighted. The list can be
scrolled (8, below).

6. Sliders for zooming view panels.
7. Sliders for scrolling along the DNA.
8. Slider for scrolling feature list.
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4. Getting around in Artemis
There are three main ways of getting to a particular DNA region in Artemis: 
-the Goto drop-down menu
-the Navigator and 
-the Feature Selector (which we will use in Exercise 4) 
The best method depends on what you’re trying to do. Knowing which one to use comes with 
practice.
4.1 The ‘Goto’menu
The functions on this menu (below the Navigator option) are shortcuts for getting to locations 
within a selected feature or for jumping to the start or end of the DNA sequence. This is really 
intuitive so give it a try!

It may seem that ‘Goto’ ‘Start of Selection’ and ‘Goto’ ‘Feature Start’ do the same thing.
Well they do if you have a feature selected but ‘Goto’ ‘Start of Selection’ will also work for
a region which you have selected by click-dragging in the main window.
So yes, give it a try!

Suggested tasks:
1. Zoom out, select / highlight a large region of sequence by clicking the left hand

button and dragging the cursor then go to the start and end of this selected region.
2. Select a CDS then go to the start and end.
3. Go to the start and end of the genome sequence.
4. Select a CDS. Within it, go to a base (nucleotide) and/or amino acid of your choice.
5. Highlight a region then, from the right click menu, select ‘Zoom to Selection’.

Click ‘Goto’
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4.2 Navigator
The Navigator panel is fairly intuitive so open it up and give it a try.

Suggestions about where to go:
1. Think of a number between 1 and 4809037 and go to that base (notice how the

cursors on the horizontal sliders move with you).
2. Your favourite gene name (it may not be there so you could try ‘fts’).
3. Use ‘Goto Feature With This Qualifier value’ to search the contents of all

qualifiers for a particular term. For example using the word ‘pseudogene’ will
take you to the next feature with the word ‘pseudogene’ in any of its qualifiers.
Note how repeated clicking of the ‘Goto’ button takes you to the following
pseudogene in the order that they occur on the chromosome.

4. Look at Appendix VI which is a functional classification scheme used for the
annotation of S. Typhi. Each CDS has a class qualifier best describing its
function. Use the ‘Goto Feature With This Qualifier value’ search to look
for CDSs belonging to a class of interest by searching with the appropriate
class values.

5. tRNA genes. Type ‘tRNA’ in the ‘Goto Feature With This Key’.
6. Regulator-binding DNA consensus sequence (real or made up!). Note that

degenerate base values can be used (Appendix VIII).
7. Amino acid consensus sequences (real or made up!). You can use ‘x’s. Note

that it searches all six reading frames regardless of whether the amino acids are
encoded or not.

What are Keys and Qualifiers? See Appendix IV

Check that the 
appropriate search 
button is on

Click ‘Goto’
then Navigator
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This part of the exercise uses the files and data you already have loaded into Artemis
from Part I. By a method of your choice go to the region from bases 2188349 to 2199512
on the DNA sequence. This region is bordered by the fbaB gene which codes for fructose-
bisphosphate aldolase. You can use the Navigator function discussed previously to get
there. The region you arrive at should look similar to that shown below.

Clearly there are many more features of Artemis which we will not have time to
explain in detail. Before getting on with this next section it might be worth browsing
the menus. Hopefully you will find most of them easy to understand.

Artemis Optional Exercise 2

CDS 
features 

Misc
features
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Once you have found this region have a look at some of the information available:

Information to view:
Annotation
If you click on a particular feature you can view the annotation associated with it:
select a CDS feature (or any other feature) and click on the ‘Edit’ menu and select
‘Selected Feature in Editor’. A window will appear containing all the annotation that
is associated with that CDS. The format for this information is constrained by that
which can be submitted to the EMBL database.

Viewing amino acid or protein sequence
Click on the ‘View’ menu and you will see various options for viewing the bases or
amino acids of the feature you have selected, in two formats i.e. EMBL or fasta. This
can be very useful when using other programs that are not integrated into Artemis e.g.
those available on the Web that require you to cut and paste sequence into them.

Plots/Graphs
Feature plots can be displayed by selecting a CDS feature then clicking ‘View’ and
‘Feature Plots’. The window which appears shows plots predicting hydrophobicity,
hydrophilicity and coiled-coil regions for the protein product of the selected CDS.

Load additional files
You should be able to see the results from Prosite searches, run on the translation of
each CDS, as pale-green boxes on the grey DNA lines. The results from the Pfam
protein motif searches are not yet shown, but can be viewed by loading the appropriate
file. Click on ‘File’ then ‘Read an Entry’ and select the file PF.tab. Each Pfam match
will appear as a coloured blue feature in the main display panel on the grey DNA lines.
To see the details click the feature then click ‘View’ then ‘Selection’ or click ‘Edit’
then ‘Selected Features in Editor’. Please ask if you are unsure about Prosite and Pfam.

Further information on specific Prosite or Pfam entries can be found on the web at:
http://ca.expasy.org/prosite and http://pfam.sanger.ac.uk/
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Notice how several of the plots show a marked deviation around the region you are currently
looking at. To fully appreciate how anomalous this region is move the genome view by
scrolling to the left and right of this region. The apparent unusual nucleotide content of this
region is indicative of laterally acquired DNA that has inserted into the genome.

The plot information is generated dynamically by Artemis and although this is a relatively
speedy exercise for a small region of DNA, on a whole genome view (we will move onto
this later) this may take a little time, so be patient.

To view the graphs:
Click on the ‘Graph’ menu to see all those available. Perhaps some of the most useful plots
are the (1) ‘GC Content (%)’, (2) ‘GC Deviation’ and (3) ‘Karlin Signature Difference’
as shown below. To adjust the smoothing of the graph you change the window size over
which the points on the graph are calculated, using the sliders shown below. If you are not
familiar with any of these please ask.

Sliders for 
smoothing 

1

2

3

DNA plots

‘Karlin Signature’
is a dinucleotide 
frequency plot 

In addition to looking at the fine detail of the annotated features it is also possible to look at
the characteristics of the DNA covering the region displayed. This can be done by adding
various plots to the display, showing different characteristics of the DNA. Some of the plots
can be used to look at the protein coding potential of translation frames within the DNA,
such as GC frame plot, and others can be used to search for horizontally acquired DNA.
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Your Artemis window should now look similar to the one shown.

As well as looking at the characteristics of small regions of the genome, it is possible to
zoom out and look at the characteristics of the genome as a whole. To view the entire
genome you can use the sliders indicated below. However, be careful zooming out
quickly with all the features being displayed, as this may temporarily lock up the
computer.
1.To make this process faster and clearer, switch off stop codons by clicking with the
right mouse button in the main view panel. A menu will appear with an option to de-
select ‘Stop Codons’ (see below).
2.You will also need to temporarily remove all of the annotated features from the
Artemis display window. In fact if you leave them on, which you can, they would be
too small to see when you zoomed out to display the entire genome. To remove the
annotation click on the S_typhi.tab entry button on the grey entry line of the Artemis
window shown above.

To de-select the 
annotation click here.

Menu item for de-
selecting stop codons

No stop 
codons shown 
on frame lines

1

2



-11-

Module 3: Artemis

3. One final tip is to adjust the scaling for each graph displayed before zooming out.
This increases the maximum window size over which a single point for each plot is
calculated. To adjust the scaling click with the right mouse button over a particular
graph window. A menu will appear with an option “Set the Window size’ (see above),
set the window size to ‘20000’. You should do this for each graph displayed (if you
get an error message press continue).

4. You are now ready to zoom out by dragging or clicking the slider indicated above.
Once you have zoomed out fully to see the entire genome you will need to adjust the
smoothing of the graphs using the vertical graph sliders as before, to have a similar
view to that shown below.

Slider for 
zooming out

Graph scaling menu

Click with the left 
mouse button in a 
graph window. A line 
and a number will 
appear. The number 
is the relative 
position within the 
genome (bps). 

Click and drag to 
highlight a region on 
the main DNA line. 
Notice that the 
boundaries of this 
region are now 
marked in the graph 
windows that you 
previously clicked in.

4

3


